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Preface
This document describes procedures for configuration and maintenance 
of HP OpenView Service Desk 3.0. Included in the document are 
instructions for setting up and maintaining user accounts and roles, 
localization, database maintenance and backup.

This guide is intended for use by any application administrator who has 
the responsibility to set up and maintain the Service Desk application 
server for client usability. This will generally mean ensuring Service 
Desk meets the procedural requirements of the user organisation. HP 
OpenView Service Desk 3.0 is an extremely flexible product, and 
virtually all functionality is customizable. This great flexibility, however, 
implies that careful consideration must be applied to the set up and 
maintenance of the product.

This guide is organized as follows:

• Chapter 1, “Accounts Administration,” on page 15 explains how to 
create and maintain accounts and roles.

• Chapter 2, “Localization,” on page 33 discribes how to install a 
localization pack and what error may occur during the process.

• Chapter 3, “Rule Manager,” on page 43 provides guidance on using 
database rules, and setting up the rule manager agent using the rule 
manager wizard.

• Chapter 4, “Server/client Settings and Issues and Configuring SSP,” 
on page 61 discusses configuration for ITP, HTTP, and SMPT for 
Self-Service Pages and servers.

• Chapter 5, “Integrating Solution Fields with Web Applications,” on 
page 71 explains how to build an integration with Service Desk into a 
Web application. It describes an example Web application provided 
with Service Desk, and provides programming instructions for the 
integration.

• Chapter 6, “System Maintenance,” on page 83 suggests procedures for 
backing up your Service Desk database.
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Revision History
When an edition of a manual is issued with a software release, it has 
been reviewed and tested and is therefore considered correct at the date 
of publication. However, errors in the software or documentation that 
were unknown at the time of release, or important new developments, 
may necessitate the release of a service pack that includes revised 
documentation. Revised documentation may also be published on the 
Internet, see the section We Welcome Your Comments! below, for the 
URL. 

A revised edition will display change bars in the left-hand margin to 
indicate revised text. These change bars will only mark the text that has 
been edited or inserted since the previous edition or revised edition.

When a revised edition of this document is published, the latest revised 
edition nullifies all previous editions.

Table 1 Revision History

Edition and Revision Number Issue Date Product Release

First Edition November 2000 Service Desk 3.0, 
Service Pack 3.
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Related Publications
This section helps you find information that is related to the information 
in this guide. It gives an overview of the Service Desk documentation and 
lists other publications you may need to refer to when using this guide.

The Service Desk Documentation
Service Desk provides a selection of books and online help to assist you in 
using Service Desk and improve your understanding of the underlying 
concepts. This section illustrates what information is available and 
where you can find it.

NOTE This section lists the publications provided with Service Desk 3.0. 
Updates of publications and additional publications may be provided in 
later service packs. For an overview of the documentation provided in 
service packs, please refer to the readme file of the latest service pack. 
The service packs and the latest versions of publications are available on 
the Internet. See the section “We Welcome Your Comments!” in this 
preface for the URLs.

• The Readme.htm file on the Service Desk CD-ROM contains 
information that will help you get started with Service Desk. It also 
contains any last-minute information that became available after the 
other documentation went to manufacturing. 

• The HP OpenView Service Desk: Release Notes give a description of 
the features that Service Desk provides. In addition, they give 
information that helps you:

— compare the current software’s features with those available in 
previous versions of the software;

— solve known problems.

The Release Notes are available as a PDF file on the HP OpenView 
Service Desk 3.0 CD-ROM. The file name is Release_Notes.pdf.

• The HP OpenView Service Desk: Supported Platforms List contains 
information that helps you determine platform and software 
requirements and compatibility. It lists the combinations of platforms 
and software Service Desk 3.0 was tested on.
  9



The Supported Platforms List is available as a PDF file on the HP 
OpenView Service Desk 3.0 CD-ROM. The file name is 
Supported_Platforms_List.pdf. 

• The HP OpenView Service Desk: Installation Guide covers all aspects 
of installing Service Desk.

The Installation Guide is available as a PDF file on the HP OpenView 
Service Desk 3.0 CD-ROM. The file name is 
Installation_Guide.pdf.

• The HP OpenView Service Desk: Data Exchange Administrator’s 
Guide explains how you can use data from other applications in 
Service Desk. It explains the underlying concepts of the data 
exchange process and gives step-by-step instructions on exporting 
data from external applications and importing it into Service Desk. 
The data exchange process includes importing single service events 
and batches of data. 

The Data Exchange Administrator’s Guide is available as a PDF file 
on the HP OpenView Service Desk 3.0 CD-ROM. The file name is 
Data_Exchange.pdf.

• The HP OpenView Service Desk: API Programmer’s Guide contains 
information that will help you create customized integrations with 
Service Desk. This guide depicts the API structure, and explains 
some of the basic functions with examples for using the Application 
Programming Interface (API) provided with Service Desk. The API 
extends the HP OpenView Service Desk environment by providing 
independent programmatic access to data-centered functionality in 
the Service Desk application server environment.

The API Guide is available as a PDF file on the HP OpenView Service 
Desk 3.0 CD-ROM. The file name is API_pg.pdf.

• The HP OpenView Service Desk: Data Dictionary contains helpful 
information about the structure of the application.

The Data Dictionary is available as an HTML file on the HP 
OpenView Service Desk 3.0 CD-ROM. The file name is 
Data_Dictionary.htm.

• The HP OpenView VantagePoint Service Desk 3.0 Computer Based 
Training (CBT) CD-ROM is intended to assist you in learning about 
the functionality of HP OpenView VantagePoint Service Desk 3.0 
from both a user and a system administrator perspective. The 
CD-ROM contains demonstration videos and accompanying texts that 
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explain and show how to perform a wide variety of tasks within the 
application. The CBT also explains the basic concepts of the Service 
Desk application.

The CBT is shipped automatically with the regular Service Desk 
software on a separate CD-ROM.

• The online help is an extensive information system providing:

— procedural information to help you perform tasks, whether you are 
a novice or an experienced user;

— background and overview information to help you improve your 
understanding of the underlying concepts and structure of Service 
Desk;

— information about error messages that may appear when working 
with Service Desk, together with information on solving these 
errors;

— help on help to learn more about the online help.

The online help is automatically installed as part of the Service Desk 
application and can be invoked from within Service Desk. See the 
following section entitled “Using the Online Help” for more 
information.

Reading PDF Files
You can view and print the PDF files with Adobe Acrobat Reader. 
This software is included on the HP OpenView Service Desk 3.0 
CD-ROM. For installation instructions, see the readme.htm file on the 
CD-ROM.

The latest version of Adobe Acrobat Reader is also freely available from 
Adobe’s Internet site at http://www.adobe.com.

Using the Online Help
You can invoke help from within Service Desk in the following ways:

• To get help for the window or dialog box you are working in, do one of 
the following:

— Press F1.

— Click the help toolbar button .

— Choose Help from the Help menu.
  11
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— Click the help command button  in a dialog box. 

• To search for help on a specific subject using the table of contents or 
the index of the help system: choose Help Contents & Index from 
the Help menu.

When you are in the help viewer, you can find help on how to use the help 
system itself by clicking the Help toolbar button:

Service Desk also provides tooltips and “What’s This?” help for screen 
items like buttons, boxes, and menus.

A tooltip is a short description of a screen item. To view a tooltip, rest the 
mouse pointer on the screen item. The tooltip will appear at the position 
of the mouse pointer.

“What’s This?” help is a brief explanation of how to use a screen item. 
“What’s This?” help generally gives more information than tooltips. To 
view “What’s This?” help:

1. First activate the “What’s This?” mouse pointer in one of the following 
ways:

• Press Shift+F1.

• Click the “What’s This?” toolbar button .

• Choose What’s This?  from the Help  menu.

• In dialog boxes, click the question mark button  in the title bar. 

The mouse pointer changes to a “What’s This?” mouse pointer .

2. Then click the screen item for which you want information. The 
“What’s This?” help information appears in a pop-up window.

To close the pop-up window, click anywhere on the screen or press any 
key on your keyboard.
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Typographic Conventions
The table below illustrates the typographic conventions used in this 
guide.

Font What the Font Represents Example

Italic References to book titles See also the HP OpenView Service 
Desk: Installation Guide.

Emphasized text Do not delete the System user.

Bold First-time use of a term that is 
explained in the glossary

The service call is the basis for 
incident registration.

Courier Menu names You can adjust the data view with the 
commands in the View menu.

Menu commands Choose Save from the menu.

Button names Click Add to open the Add Service 
Call dialog box.

File names To start the installation, double-click 
setup.htm.

Computer-generated output, such as 
command lines and program listings

If the system displays the text
C:\>dir a:
The device is not ready
then check if the disk is placed in the 
disk drive.

Courier bold User input: text that you must enter in a 
box or after a command line

If the service call must be solved 
within 30 minutes, enter 30.

Courier italic Replaceable text: text that you must 
replace by the text that is appropriate 
for your situation

Go to the folder X:\\Setup, where X is 
your CD-ROM drive.

Helvetica bold Keyboard keys

A plus sign (+) means you must press 
the first key (Ctrl in the example), hold 
it, and then press the second key (F1 in 
the example).

Press Ctrl+F1.
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We Welcome Your Comments!
Your comments and suggestions help us understand your needs, and 
better meet them. We are interested in what you think of this manual 
and invite you to alert us to problems or suggest improvements. You can 
submit your comments through the Internet, using the HP OpenView 
Documentation Comments Web site at the following URL:

http://ovweb.external.hp.com/lpe/comm_serv

If you encounter serious errors that impair your ability to use the 
product, please contact the HP Response Center or your support 
representative.

The latest versions of OpenView product manuals, including Service 
Desk manuals, are available on the HP OpenView Manuals Web site at 
the following URL:

http://ovweb.external.hp.com/lpe/doc_serv

Software patches and documentation updates that occur after a product 
release, will be available on the HP OpenView Patches Web site at the 
following URL:

http://ovweb.external.hp.com/cpe/patches
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1 Accounts Administration

This chapter discusses the administration and maintenance tasks 
associated with User and Administrator Accounts, their permitted access 
rights and other security related issues.
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Accounts Administration

Accounts
Accounts
In a typical set-up, Service Desk requires three types of user accounts, a 
database user, an application administrator, and at least one end user. 
This set-up, is of course, variable. For instance, if you are using an Oracle 
database you will be using two database accounts (a database user and a 
repository user), or if you are only using the client software installed 
with the application server you will not have any user accounts. Large 
organisations may be using multiple application servers, as well as a 
large number of end users, but the increased number of accounts will 
always retain the same end user account, administrator account, 
database user account relationship.

When you install the Service Desk application server, you will also have 
to define a new, or specify an existing, database administrator account. 
However, once the database is set up and the application server is 
installed, Service Desk will not use this account again.

Types of Accounts

As mentioned above, there are three types of accounts:

• Database user accounts. 
The Service Desk application server uses these to communicate with 
the database. If you are using an SQL Server database there is only 
one database user needed per AppServer - Database relationship, but 
if you are using an Oracle database there are two accounts (a 
database user and a repository user) per AppServer - Database 
relationship. By AppServer - Database relationship we refer to the 
communication between a single application server and a single 
database. 

• Service Desk Administrator account.
Each installation of the Service Desk application server must have at 
least one Service Desk administrator account. This administrator 
account has all the Roles and authorization requirements to access 
every function of the Service Desk application. The Service Desk 
administrator counts as one of your licensed users.

The Administrator account has the default user name of “System” 
with the default password of “servicedesk” and is case sensitive.
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Accounts Administration

Accounts
• Client accounts.
The number of end user Client accounts is dictated by the number of 
licenses purchased, and their access to Service Desk functionality is 
limited by the Roles assigned to them. Roles are assigned to user 
accounts by the Service Desk administrator at the time the accounts 
are created and they can be modified at any time. The Service Desk 
user account details are stored in the user’s Windows profile by the 
connections wizard. The users will not have to enter their log on name 
and password each time they start Service Desk as it will be read 
from the Windows profile, although you specify that clients must log 
on each time they connect to application server (see “Logon Screen” 
on page  31). However, each time a user (that does not have to log in) 
tries to access Service Desk from a client machine that he has not 
used before, the connection wizard will be started and when the 
connection is made entries will be added to the Windows profile and 
registry.

A client account can be used in either two tier or three tier mode. 
Three tier mode is when the client connects to the database via the 
application server. The vast majority of user accounts ought to 
connect in three tier mode. Two tier mode is when a client connects to 
the database directly, bypassing the application server. Two tier mode 
will usually only be used for technical reason, for instance when 
debugging. When two tier mode is used Database rules are not kicked 
off, as the application server is missing.

There are two more variations of the Client account. These are 
non-UI accounts for data exchange and Self-Service Pages (SSP) 
users. These accounts can not log in Service Desk, but they can send 
data to the application server and database. However, they are not 
counted among the licensed users.

Licensing

For information about how to get and install your license keys, see 
Chapter 4 of the HP OpenView Service Desk 3.0 Installation Guide.

You must not create more user accounts than your license permits. If  
you have used a temporary license key to create more users than you 
have a permanent license for, you must delete the extra users before the 
temporary license key runs out. If you do not, all access to Service Desk 
will be denied at the expiry date. 
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Accounts Administration

Accounts
The number of licensed users is the maximum number of users who can 
be logged into Service Desk at any one time.

When entering your license key in Service Desk, enter it exactly as 
shown, without quotation marks; it is case-sensitive. 

Creating Accounts

Once you have created their accounts, the users must connect to the 
Server using the Connections Wizard before they can log into the Service 
Desk client on their machine. It is worth bearing in mind before creating 
a user account that the user must enter specific details in the 
connections wizard and that you must provide this information to them. 
It may also be worthwhile to prepare some standards in advance. For 
instance, you may decide that the user’s log in name for Service Desk 
should be the same as that for NT to minimise confusion, or that the 
Friendly Name (which the user can edit in the wizard) should follow 
some sort of specific format for consistency. To complete the connections 
wizard, the user must be informed of the Service Desk application server 
host name. 

Before users can access Service Desk, their accounts must each be 
assigned a Role. There are two ways to assign a role to an account, one is 
described at the end of this section below, and the other in described in 
the following section that discussed Roles.

To create an account, do the following: 

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Account.
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Figure 1-1 Administrator console dialog box

5. Right-click in the Account view and choose New Account from the 
popup menu. The Account dialog box is displayed:
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Figure 1-2 Account dialog box

6. Type the name to be displayed when referring to this account. This is 
the name that will normally be displayed, for instance, in the Active 
Service Desk sessions tab page.

7. Enter the login name that the user will use to log in to Service Desk. 
This may be the same as the user’s NT log in, but it is not required. 

8. Enter a password, and confirm the entry. This may be the same as the 
user’s NT password. There are no rules for the password, it can even 
be left blank, but this is not advisable. If you provide the user with a 
password they can change it by using Options from the Tools menu 
and then selecting Accounts and then Change Password.

9. Enter the name of the users ‘home’ machine in the Host field, this 
will be used by the Service Desk agent when processing actions. If the 
user logs onto Service Desk from a different machine, actions 
processed by the agent will still be routed to the user’s home machine 
 Chapter 120



Accounts Administration

Accounts
unless this field is changed to the new machine.

10.Use the Blocked checkbox to ensure that the account cannot be used. 
This may be a useful alternative to deleting an old or redundant 
account.

11.Check the Use this account for... checkbox if the account is 
being created for a user who will not be logging into Service Desk 
directly but who will be using Integrations or the Self Service Pages. 
This account is not included as one of the licensed accounts.

Modifying Accounts

Once created, a user account can be changed at any time. 

To modify an account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Account.

5. Select the account you want to modify. Right-click in the Account 
view and choose Open from the popup menu.

6. In the account dialog change the details as required.

Disabling and Removing Accounts

User accounts can be fully removed from the system, or disabled 
(blocked) so that they cannot be used. 

When you delete an account you must first remove any associated 
records in the database, for example, service calls. For this reason it is 
often preferable to block an account rather than physically delete it. 
However, if the account is only blocked, it still counts towards the total 
for licensing purposes.

To block an account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.
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4. In the Access branch, select Account.

5. Select the account you want to block. Right-click in the Account view 
and choose Open from the popup menu.

6. In the accounts dialog box, use the Blocked checkbox to ensure that 
the account cannot be used. 

To remove an account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Account.

5. Select the account you want to remove. Right-click in the Account 
view and choose Delete from the popup menu. A popup dialog box is 
displayed.

6. Choose Yes to delete the account. If the account has no links to other 
items, for example, a person record, or work orders, it will be deleted. 
If the account does have links to other items a dialog box will be 
displayed listing all the associated items:

Figure 1-3 Account - Remove linked items dialog box
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7. Select each item individually and click Remove. This will physically 
remove the record from the database. When all linked items have 
been removed, you can delete the account.

Adding a Role to an Account

Before an account can be used to access Service Desk, a Role must be 
assigned to the account. 

To assign an existing role to a new account:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Account.

5. Right-click in the Account view and choose New Account from the 
popup menu. The Account dialog box is displayed. Create a new 
account as described above in the section “Creating Accounts” on 
page  18. 

6. Click the Roles tab, and select the check boxes for the roles that the 
user needs. An account can have multiple roles.

Figure 1-4 Account - Adding a role to an account
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The access rights that an account has to Service Desk are defined by 
applying a Role, or multiple roles, to the account. 

Role gives a user access to items and specific rights to manipulate those 
items. An item is a specific type of database record, for instance a Service 
Call, a Work Order, or a Change. There are 11 types of items used in 
Service Desk. Each item type can be Inserted (created), Modified 
(edited), Viewed (read), and Removed (deleted). Some item types also 
have templates that need to be maintained. 

A role therefore can be created for each particular job function in an 
orgnization that needs access to Service Desk. Roles can be combined to 
create high level roles, or taylored for single individuals.

To create a Role:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, expand the Security node.

4. In the Access branch, select Role.

Figure 1-5 Administrator console dialog box
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5. Right-click in the Role view and choose New Role from the popup 
menu. The Role dialog box is displayed:

Figure 1-6 Role dialog box

6. Enter a name for the new Role, this is the name that will be displayed 
in the Role view of the Administrator Console. 

7. Select the check boxes for the access rights you want the role to have. 
If you select the main check box for each item (to the left of the icon), 
all the access rights for that item will be selected. If you don’t want to 
give the role the ability to use all access rights for any item, select 
just the access rights needed.

8. Roles can be fine tuned to allow or deny access to particular fields, 
forms, view, templates, and actions.
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Advanced item access 

For fine tuning access to selected items can be further defined so that 
specific fields, forms, views, templates, and actions can be hidden from 
all users with particular roles.

To allow or restrict access to fields, forms, views, templates, and actions:

1. In the role dialog box select the item you wish to further define. Click 
Advanced. The Item Access dialog box is displayed.

2. Click the tabs to select fields, forms, views, templates, or actions. 

3. If you select the Fields tab, and do the following: The list displays 
all fields available for the item you selected in the Roles dialog box. 
The default is that all fields are writable. Select the fields that you 
want to make invisible, or view only, to the user with the previously 
select role. Click the Write, View, or Hide buttons.

Figure 1-7 Roles - Item Access dialog box

4. Select the forms, views, templates, or actions tabs and do the 
following: The default is that there are no forms, views, templates, or 
actions assigned to the item, these can be added to the item by either 
creating new or adding existing ones. To create new forms, views, 
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templates, or actions click the New button (this procedure is 
described in the online help). To add existing forms, views, templates, 
or actions click the Add existing button and select an item from the 
displayed list.

Figure 1-8 Roles - Forms, views, templates, and actions dialog box

5. Once forms, views, templates, or actions have been added they can be 
modified or removed by clicking on the Modify or Remove buttons. 

6. With forms, views, and templates, you can define one of the available 
items as a default.

Including Roles within Roles

On some occasions it may be more efficient to combine two or more 
existing roles to create a new role, rather than to duplicate the work. 

However, it should be remembered that any existing roles you use to 
create a new role may already have other roles included within them. 
When a role is created using a combination of existing role, the new role 
will have the access rights of all the included roles. This could mean that 
the new role may end up having as much access as the system 
administrator role. 
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To include a role within a role:

1. Access the Role dialog box as described above.

2. In the Role dialog box, click the Include Roles tab.

3. Select the roles to be included in the new or modified role.

Figure 1-9 Role - include role

Linking Roles and Accounts

Roles can be linked to one or more existing user accounts at the time the 
role is created, or at any time using the method described below. The 
accounts displayed in the dialog box are all your licensed users.

To link a role to an account:

1. Access the Role dialog box as described above.

2. In the Role dialog box, click the Accounts tab.

3. Select the checkboxes for the accounts that will utilize the new or 
modified role.
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Figure 1-10 Role - Link accounts
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It is important that the NT account that starts up the HP OpenView 
Service Desk Service has access rights to all servers, drives, and folders 
that Service Desk may need to use. 

If the NT Service start up account does not have sufficient rights, some of 
the functionality of Service Desk may be lost. For example, one feature of 
Service Desk is that it can be set up to automatically create a service call 
when it receives an e-mail from a customer, this e-mail is then included 
with the service call as an attachment. However, the e-mails are stored 
in a specific attachments folder (sometimes on a dedicated file server), 
and so if the start up account does not have access rights to this folder a 
service call is not created and the e-mail is not stored. 

Ensuring that the start up account has sufficient access right is also 
relevant when making database dumps to shared drives, the start up 
account must have access to the shared drive.
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Two simple features help maintain security of Service Desk.

Time Outs
A session is created on the server whenever a user starts the Service 
Desk on their client machine. If the client console is inactive for more 
than the timeout period, the session will be removed. Consequently, the 
user must log on again to create a new session. The user will not receive 
any online notifications when the session has been removed from the 
server. 

The timeout is a simple way to ensure that unauthorized persons do not 
attempt to access the Service Desk database, and is used to make sure 
that client connections do not remain open indefinately. Removing 
unused sessions also frees up system resources. The timeout applies 
equally to all client accounts, and is set by default to 120 minutes.

To change the timeout period:

1. On the server, locate the configuration file <service desk 
root>\server\sd.conf in the Service Desk application directory 
structure. This is the main Service Desk application server 
configuration file. 

2. Find the section “Session.timeout” and edit the time (in minutes).

3. Save the file.

Logon Screen

Service Desk can be set up to display a dialog box whenever a user tries 
to connect to the application server. The user will be required to enter 
their user name, password, and the database to which they will connect. 
This feature applies to all client connections.

To set Display Logon Screen:

1. Start the Service Desk application server.

2. From the Tools menu, choose System.

3. In the Administrator Console, select System Panel.
Chapter 1  31



Accounts Administration

Security
4. In the System Panel view double-click the General Settings 
icon.

5. In the General Settings dialog box select the Display Logon 
Screen On Startup checkbox.

Figure 1-11 General Settings dialog box
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2 Localization

This chapter discusses how to import the XML files provided with the 
localization pack and how to implement the localized online help.
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The Localization Pack
The localization pack consists of:

• checkloc-oracle.sql and checkloc-sqlserver.sql. These are 
scripts to check the localization codes in the respective database

• sd30lang_xx.xml One or more language XML files (where xx is the 
language code)

To install a new language:

1. Create a new language in Service Desk (always start from the 
English language). Select System from the Tools menu to open the 
Administrator console. Next, in the System Panel select Regional 
Settings. The Regional Settings screen opens:
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Figure 2-1 The regional settings screen

2. In the Regional Settings screen, click Add. The New Language dialog 
box appears.

3. In the New Language dialog box, select the new language from the 
drop-down list, next click Apply and then OK.

NOTE Make sure you choose one of the following languages:

German (Standard)

French (Standard)

Spanish (Traditional sort)

Japanese 
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Korean 

If you choose any other language, like for instance Spanish (Modern 
sort), the localization will not succeed and the language will still be 
set to English.

4. After closing the Regional Settings screen, you return to the 
Administrator console. Select the Data node, then Data Exchange 
and Data Exchange Tasks.

a. Double-click the import mapping file sd30lang

b. Clear the export check box.

c. Click Browse to select the translated XML file name, for example 
sd30lang_german.xml

d. Select the import box

e. Enter a Service Desk username and password, for example 
system/servicedesk

f. Select the import mapping file sd30lang

g. Select the Debug check box if you want additional information in 
the log file

h. Click OK. The XML file will be imported into Service Desk.
The import mechanism will only perform updates, because it uses 
the record object ID and language object ID to find the 
corresponding localizable item.

5. Click the List log files button if you want to examine the log file 
data_exchange\log\<import mapping>.log for any errors or 
warnings.

The following errors and warnings can be ignored:

• Attribute not defined: Comments on entity x (ID=y)

• No changes to save (including stack trace in debug mode)

• Program error: the attribute “Language” of this label text cannot 
be modified, because the label text record was opened in view 
mode or because the attribute is read-only while processing 
attribute Language (text can appear in the imported language)
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• Program Error: the attribute “Localizable item” of this label text 
cannot be modified, because the label text record was opened in 
view mode or because the attribute is read-only while processing 
attribute Object ID (text can appear in the imported language)

Common Errors:

• The maximum length of 255 characters has exceeded while 
processing attribute :Text”. Most texts, like message texts and 
“What’s this” texts, have a limit of 255 characters.

• More than one item found while processing attribute Object ID. 
This only happens in the Labels section and can be ignored for 
now.

• com.hp.ifc.ext.ExternalException: you are not allowed to create 
new items of this type. Sd_import normally tries to create new 
items if it cannot find an existing one. This means that there are 
no object IDs in the XML that do not exist in the repository. This 
occurs if:

— the user removes views, actions, forms or tab controls so the 
object cannot be translated anymore.

— no language has been created yet. In this case all imported 
items result in this error message.

6. Run checkloc-oracle.sql in SQL*Plus (for Oracle), or 
checkloc-sqlserver.sql in the Query Analyzer (for SQL server) as 
the SD repository owner, for example sd_repo

7. Examine the log file checkloc.log on:

• Items that have not been translated: these items do not have a 
recent modification date. In this case, use the Object ID to find the 
entry in the XML file to find the internal ID, and use this ID to 
find out what the message is in the import log file.

NOTE This can also be caused by the fact that the translated text is the same as 
the original English text (No changes to save).

• Items that have a new creation date in English (language code 
1033). These items have been added recently by an upgrade or by 
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the user himself, for example new form titles or tab controls. These 
items must be translated manually.

NOTE This mechanism can be used for an extended or modified localized XML 
file to fit your specific needs, for example extra form titles can be added 
or translations can be changed. As long as the XML specific format 
remains correct, you can alter the file or take portions to do partial 
imports.
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Localizing sd_event and sd_export
Localization issues for sd_event and sd_export are solved by providing 
a message text file in which all localized data is put, for example 
sd_event_gb.msgs.

[ERROR_CODES]
1010 No application server specified
1020 Cannot open the log file
1030 Failed to create socket
1040 Could not connect to the application server
1050 The application server is down
1060 Check the http flag in sd.conf
1070 Invalid path:
1075 Configuration file does not exist
1080 Invalid modus:
1085 No modus specified
1090 No mapping specified
2000 No logon/password specified
2010 Invalid port number
2020 No port number specified
2030 No section found in the configuration file
2040 No class name specified
2050 No sections found in configuration file
2060 Value list may be empty
2070 You may check the http flag in sd.conf
2080 Possibly no application server specified or the value list is empty
2090 Configuration file must be the first argument [-f configuration file]

Other language files, for example sd_event_nl.msgs, can easily be 
made. The last two characters define the language. The language files 
normally can be found in the same directory as sd_event and sd_export 
(bin directory).
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Implementing the Help Files
This section explains where on the user’s system the help files will 
automatically be placed to make the help available with the application.

When you install Service Desk 3.0, Service Pack 3, all online help .CHM 
files will automatically be placed in the folder 
Service_Desk_installation_folder\repo\locales\locale_identif
ier where:

• Service_Desk_installation_folder is the folder where Service 
Desk is installed, by default Program 
Files\Hewlett-Packard\OpenView\Service Desk

• locale_identifier is the identifier for the locale, for example 1033 for 
US English. For a complete list of locales, see below. This folder is 
automatically created when you create a new language in Service 
Desk. the new language must be created on each client machine. For 
instructions on how to create a new language in Service Desk, refer to 
Service Desk’s online help, Step 1 on page  34. 

Also, the six header files are placed in the same folder as the CHM files. 
The header files are required for context-sensitive help: they determine 
which help topic is invoked when a user presses F1 in a Service Desk 
screen.

The header files are the same for all languages/locales. The files will be 
automatically placed in the same folder as the CHM files when you 
install Service Desk 3.0, Service Pack 3.

• APPdataforms.h

• APPdataviews.h

• APPmessages.h

• APPothers.h

• IFCdataforms.h

• IFCdataviews.h

The identifiers for the locales are as follows:

• 1031 German

• 1033 English (US)
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• 1034 Spanish

• 1036 French

• 1041 Japanese

• 1042 Korean
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3 Rule Manager

Rules can be created using the Rule Manager to initiate actions in 
response to events that occur in the Service Desk database. A database 
event is defined as an insertion, deletion or modification to a database 
record. 
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The Rule Manager can help you optimize your Service Desk processes by 
using database rules to automatically perform actions. When you create 
a database rule, Service Desk applies the rule when an item is created, 
change, or deleted in the database. When the conditions you set for the 
rule are met, the action you specified for the rule will be executed. The 
Rule Manager is capable of performing three different type of actions; 
Command Exec actions, the Send Electronic Mail actions, and actions to 
Update Data in Service Desk. The steps involved in creating a rule and 
how you can use the different type of actions are explained in detail in 
the following sections. 

The following diagram shows the overall concept of how the Rule 
Manager functions. Rules are maintained by the Rule Manager and 
stored in the Service Desk database. The Rule Manager also performs 
the vital task of pulling event information from the event queue to 
determine if the rules apply to the event. A numbered referencing of 
what occurs at each step in the process, follows the diagram:
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Figure 3-1 Rule Manager Concept

1. An event occurs in the Service Desk database.

2. The event is sent to the Event Queue by the Service Desk workflow 
layer.

3. The Rule Manager takes the event from the queue and checks to see if 
there is an applicable rule for the event. If a rule does not exist for the 
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event, the event will be discarded.

4. Events that fit a rule are sent to the Evaluation Manager to check the 
conditions set for the rule.

5. If no conditions exist or if all conditions are met the event is sent to 
the Action Manager and executed. 

• Events with timed conditions are sent to the Alarm Engine.

• An alarm goes off at the time specified by the timed condition and 
the timed condition is evaluated by the Evaluation Manager. 
Non-timed conditions are not re-evaluated, they are only 
evaluated once.

6. When the timed condition is met the event is sent to the Action 
Manager.

7. The Action Manager can initiate the following three tasks:

• Command Exec actions are sent to the Rule Manager Agent to be 
executed.

• Electronic Mail actions are sent to outbound server to be executed.

• Update Data actions cause the triggering item to be updated.

NOTE E-mail actions and Update Service Desk database actions do not use a 
Rule Manager agent.

About the Agent

The Rule Manager Agent is only used to execute Command Exec actions. 
It is not used when performing actions to update the Service Desk 
database. The agent can be installed on Windows NT and UNIX 
machines. For installation and activation instructions refer to the HP 
OpenView Service Desk Installation Guide.

Resending Failed Actions

When a Rule Manager action cannot reach the agent it is intended for, 
that action is stored on the Service Desk application server with the 
agent’s name. When the agent is active again it calls the Service Desk 
application server and gathers the actions assigned to it. The Service 
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Desk application server is only capable of storing events that failed to 
reach the agent, not resending them. If the server goes down all of the 
waiting actions will be lost.

Creating Database Rules

The procedure below explains how you can use the Rule Manager wizard 
in Service Desk to create a database rule:

Step 1. Select the item in Service Desk that this rule will apply to:

1. From the Tools menu select System. In the Administrator Console 
double-click Business Logic and then Database Rules.

2. Select a Service Desk item, for example the Incident item is used:

Figure 3-2 Select a Service Desk item

3. Right-click in the Database rule window and select New Database 
rule from the menu that appears.
As an alternative you can select one of the example rules we provide 
and modify it to fit your organizational needs.
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Step 2. Set conditions for the database rule.

1. Specify when you want to apply to the rule. For this example we want 
to send service event data when an incident is modified, so select 
“When incident is modified”. Click Next to continue.

2. In the following dialog box, click Add to set conditions for the 
database rule

Figure 3-3 Add Conditions

3. Use the Field button in the Condition dialog box to enter the item 
fields you want the rule applied to, you must enter at least one field. 
Two conditions were entered in this example:
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Figure 3-4 Configure Conditions 

4. Enter an Operator using the drop-down arrow.

5. Put your cursor in Value field and use the Field button to select the 
value you want the fields selected to be measured by. For example, 
this rule will be applied when the Incident field Registration 
contains the value; managex4_event.

6. Select Schedule the validation of this condition at check 
box to enter a timed values for this condition. Set a time range, and 
then a field using the Field button to measure the time value 
against. This is not a mandatory step.

7.  Click OK, then Next to continue.

Step 3. Add actions to the database rule.

1. Click Add to add an action.You must specify at least one action for the 
rule. You can select the Command Exec action, Send E-mail Message 
action or the Update Data action. For this example the Command 
Exec action is used to send service event information to a third-party 
application that is integrated with Service Desk:
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Figure 3-5 Add Actions

2. Enter an identifying Name for the action:
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Figure 3-6 Create a Command Exec Action

3. In the Description field, enter a brief explanation of the action that 
will be performed.

4. In the Host field, enter the name of the computer the action will take 
place on. In the Host field you can use the Field button to specify 
the [Registration>created by> hostname]. If the action is in 
response to a message sent by an external application the host name 
can automatically be taken from that account and filled in. For 
example, if a message is being sent to ManageX, the host will come 
from the applicable Service Desk account, for example 
ManageX_event, that originally sent the incident to Service Desk.
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5. Clear the Blocked check box to activate this action.

6. In the Command line field, enter the command you want to execute, 
for example: sendmessage.exe

7. In the Parameters field define additional information for the 
command by inserting parameters using the Field button, for 
example:

Message number=[ManageX Message] (The ManageX message 
number will be inserted when the service event is sent)

8. Click OK and then Next to continue.

Step 4. Turn on the action:

1. In the Name field enter an identifying name for the rule. This name 
will appear in the database rule window for that item.

2. Clear the Block this rule check box to turn the rule on.

3. Click Finish to save the rule and return to the Administrator 
Console.

Creating Command Exec Actions

The Command Exec action is used to execute a command with a set of 
parameters specified by you. This action can be used for example to send 
event information to a third-party application, or to start another 
application such as a banner program. This section includes a number of 
examples. A number of examples are also available in the demo 
database. To configure a Command Exec action:

1. Enter a Name for the action in the action dialog box.

2. In the Description field, enter a brief explanation of the action that 
will be performed.

3. Enter the name of the Host computer the action will take place on. If 
the action is in response to a message sent by an external application, 
the host name will automatically be taken from that account and 
filled in. For example, if an acknowledgment message is being sent to 
ITO, the host will come from the account that originally sent the 
incident to Service Desk. 

4. Enter the Command you want to execute, for example: 
c:\programfiles\ITO\Bin\ITO_ack.exe
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5. In the Parameters field, define additional information for the 
command by inserting parameters using the Field button.

6. Clear the check box labeled Blocked to activate the action, then click 
OK to return to the Rules Wizard.

Example 3-1 Example Rule for Sending a Service Event

The Rule Manager in Service Desk is the starting point for setting up 
database rules to send outbound service events. The following procedure 
is used to create a database rule for sending a service event from Service 
Desk to another application. The following example shows how a 
database rule is created for sending an acknowledgement message to the 
VantagePoint Operation application:

Example 3-2 SLA Expiration Alert Action

The Command Exec action can be used to send a notification showing a 
banner on the screen of the Service Level Agreement manager when an 
SLA is going to expire within 28 days. The following dialog boxes show 
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the conditions set for the rule:

The Command Exec action is used to show a banner when configured as 
follows:
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Example 3-3 Send Banner

Set conditions:

Set action
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Creating Email Actions

The Send Email Message action contains parameters that you enter that 
will determine the message text used when sending email messages. For 
example, this action can be used to send email about a Service Call to a 
Manager when it is approaching the resolution deadline. The parameters 
entered might include; the Service call number, the specialist assigned 
the service call, the deadline, status, caller, and the text from the 
Information field. To configure an Electronic Mail action:

1. Enter a Name for the action.

2. In the Send to field, enter the email addresses where the e-mail 
messages should be sent. You can also use the Field button to enter 
field related addresses such as [person:Assignment], this will send 
the e-mail message to the person assigned the item.

3. Enter the Subject. You can use the Field button to insert the service 
call number or other information taken from the Service Desk item.

4. In the Message field compose the e-mail message to be sent by 
inserting parameters in the message shown in brackets, for example:
Service call [Number] is almost overdue.
Specialist [Assignment to person].
Deadline [Deadline].
Status [Status].
Caller [Caller].
Information [Information]. (information from the Service call 
information field will be inserted)

5. Clear the check box labeled Blocked to activate the action, and click 
OK to return to the Rules Wizard.

NOTE The SMTP server must be configured properly, refer to the HP OpenView 
Service Desk: Installation Guide for additional information.

NOTE The outbound side of the email interface (sd.conf: 
smtp.outbound.server=) should NOT be sent to an MS Exchange 
server, since Exchange does not use SMTP. (There are SMTP gateways 
available for Exchange, but Exchange alone is insufficient.)
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NOTE To enable sending an email to a specific machine you may have to add an 
"MX" record to the DNS tables to explicitly allow that machine to use it’s 
SMTP port. (There are two kinds of DNS authorizations: A scheme that 
allows anything that is not forbidden, and a scheme that needs explicit 
approval for anything that is possible.)

You can check whether your machine is registered at the DNS tables by 
running the following from a DOS prompt: C:\> nslookup -type=mx 
<hostname>

If the DNS tables are set up OK, then the <hostname> machine should 
appear in the list of MX preferences and one of the mail-exchanger 
settings points to <hostname>.

Example 3-4 Example for Sending Email when CI status changes

Set conditions
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Configure the Send E-mail action as follows:

Example 3-5 Escalation Message

Set Conditions:
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Set the action parameters:

Creating Actions to Update Service Desk Data

The Update Data action is used to update data in the Service Desk 
database. For example you could use this action to automatically fill-in 
the Actual Finish date when a Service Call is put in a Closed status. To 
fill in the dialog box:

1. Enter a Name for the action.

2. Use the Field button to select what fields you want updated, select 
an Operator using the list button, and then select a Value to be 
applied to the field using the list button. The following table explains 
some of the less obvious parameters:

Parameter Description

Set to system The Value field will be blank. The system date and 
time will be used.

Set to system + In the Value field enter the time you want to add to 
the system time.
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3. Use the Add to List button to move the information you selected to 
the Assign new values to fields window.

Set to system - In the Value field enter the time you want to 
substract from the system time.

Make empty Value field will be blank. The value that is there is 
NULL.

Parameter Description
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4 Server/client Settings and 
Issues and Configuring SSP

This chapter discusses how to configure SSP and server/client settings 
and issues.
Chapter 4 61



Server/client Settings and Issues and Configuring SSP
Configuring SSP
Configuring SSP
In the Self Service Pages, you can easily configure the links, fonts and 
the customer header. 

To configure the links and the customer header, you must adjust the 
HTML page.

To configure the customer header:

1. Go to the file CustomerHeader.html

2. Open the file with an HTML editor such as Microsoft FrontPage 
Editor

3. In FrontPage editor, change “Your company logo” to the text of your 
choice

4. Save the file in the Multilingual (UTF-8) language

NOTE When you set the language to Multilingual, make sure you set it to 
UTF-8 Unicode format, otherwise your text will not be displayed.

To configure the links:

1. Go to the file CustomerLinks.html

2. Open the file with an HTML editor such as Microsoft FrontPage 
Editor

3. Replace the default links by the links of your choice

4. Save the file with the Multilingual (UTF-8) language

NOTE In this case, it is equally important to set the language to Unicode 
format, otherwise the links will not be displayed properly.

To configure the font:

1. In the file hp.ITSM.CSS, change the default fonts to the fonts of your 
choice
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2. Save the file

Server/client Settings and Issues

Below, the following settings and issues from the file sd.conf are 
described:

• server.root

• session.timeout

• ITP service

• itp.port

• itp.joinMultipleServers

• itp. weight

• itp.acceptConsoleClients

• HTTP Post Service

• SMTP Service for inbound e-mail

• SMTP Service for outbound e-mail

• Log options

Server.root

This is the top of the directory tree where the server’s configuration, 
error and log files are being kept: C:/Program 
Files/Hewlett-Packard/OpenView/ServiceDesk/. This path is only 
used on non-Windows systems. 

For Windows systems, the path is set in the registry under: 
HKEY_LOCAL_MACHINE/SOFWARE/Hewlett-Packard/OpenView/Service 
Desk/ where key “ProductPath” is used.

Session.timeout

Session.timeout is the user’s session timeout on the server in minutes. 
When a user starts the GUI console, a session is created on the server. If 
the user keeps the GUI console inactive for more than the given amount 
of minutes, the session on the server will timeout and will be removed. 
This frees up resources on the server. This also acts as a security 
measure.
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After the session is removed from the server, the user must log on again. 
This happens automatically when the user starts working with the 
application again. The user will not notice that the session was 
terminated apart for the amount of time that is needed to reconnect to 
the server and log on again.

NOTE When the session is removed from the server, the user will not receive 
any online notifications if an item is assigned to him.

Default for session.timeout is 120.

ITP Service

ITP is an IT Service Manager prorietary transport protocol built on top of 
TCP/IP. It is comparable to HTTP, but ITP is in binary format and a lot 
more efficient. The ITP service is used by all Service Desk clients, 
Service Desk agents and the Service Desk Self Service Pages (SSP) 
module.

itp.port

The itp.port is the IP port that the ITP service should listen to. Default 
value is 30999.

If the IP port specified is not the default, then all clients must specify the 
given IP port when they connect to the application server, for example: 
mymachine.mydomain.com:12345.

If you use multiple application servers, make sure all application servers 
run on the same IP port to run the ITP service.

itp.joinMultipleServers

itp.joinMultipleServers specifies whether an application server 
must join other application servers to serve Service Desk clients.

itp.joinMultipleServers can be set to:

• “false”, if only one application server is being used to serve all clients

• “true”, if more than one application server is being used to serve all 
clients.
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TIP Running multiple servers will give a more fail-save environment. If an 
application server goes down or the network to the server is slowed 
down by excessive traffic, all clients connected to that server will 
automatically reconnect to the other application servers.

itp.weight

The weight parameter itp.weight expresses which servers are better 
resourced than others. The weight parameter must be an integer value. 
The higher the value, the more clients the application server will take.

Example 4-1

Server A has weight 10 and server B has weight 2. The first 5 clients will 
connect to server A, the next to server B, the next 5 to server A, the next 
to server B and so on.

itp.acceptConsoleClients

The parameter itp.acceptConsoleClients, when set to:

• “true”, indicates that this application server will be used to serve 
clients that use the GUI console

• “false”, indicates that clients using the GUI console will not be 
accepted to connect to this application server

This parameter is used for load-balancing purposes, where the 
application server could be used solely to support web clients, or to 
support all functionalities related to integration with other products 
such as NNM, ITO, ManageX, etc.

accept and deny

With the accept and deny parameters, you can explicitely exclude and/or 
include specific IP addresses and/or complete IP subnetworks from 
accessing the services offered by ITP. If you don not specify anything, ITP 
will accept connections from any IP address.

Example 4-2

The star symbol denotes any number between 0 and 255:
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itp.accept=127.0.0.1
itp.accept=12.34.*.*
itp.deny=123.45.67.88
itp.deny=123.45.67.89
itp.deny=123.45.67.90
itp.deny=123.98.76.*

HTTP Post Service

The application server can run an HTTP Post Service. This service 
makes it possible to receive events form third party products such as 
NNM, ITO, ManageX, etc.

HTTP can be set to:

• “false” if the application server does not need to offer the HTTP Post 
Service

• “true” if the application server should offer the HTTP Post Service

The default setting for http is: http=true

http.port

The parameter http.port defines the IP port the HTTP Post Service 
should listen to.

The default setting for http.port is: http.port=30980

accept and deny

With the accept and deny parameters you can exclude and/or include 
specific IP addresses and/or complete IP subnetworks from any IP 
address. The star symbol is used to denote any number between 0 and 
255.

http.accept=*.*.*.* (accept all IP addresses)
http.deny=12.34.56.78 (deny a specific IP address)

NOTE If you have a webserver serving the Self Service Pages running on a 
machine that has for example IP address 12.34.56.78, then uncomment 
the two lines above. This ensures that only that webserver accesses the 
Chapter 466



Server/client Settings and Issues and Configuring SSP
Configuring SSP
HTTP Post Service offered by this application server.

SMTP Service for Inbound E-mail

The application server can run an SMTP service, which can be used to 
receive e-mail messages that will be converted to a service call in Service 
Desk. The SMTP service conforms to the Internet RFC 821 and RFCs 
2045 to 2049.

The parameter smtp can be set to:

• “false” if the application server does not need to offer the SMTP 
service

• “true” if the application server must offer the SMTP service

smtp.debug

The parameter smtp.debug can be set to:

• “true” when for all e-mail messages debug information must be 
written to the log file

• “false” when for all e-mail messages debug information must not be 
written to the log file

The default setting for smtpdebug is: smtdebug=true

smtp.port

The parameter smtp.port defines the IP port the SMTP Service must 
listen to. The default setting for smtp.port is: smtp.port=25

smtp.user

The parameter smtp.user defines the username that you can send an 
e-mail message to.

Example 4-3

If smtp.user equals “servicedesk” and this application server has the 
hostname “mycomputer.mydomain.com”, then people can send e-mail to 
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servicedesk@mycomputer.mydomain.com.

With the accept and deny parameters you can exclude and/or include 
specific IP addresses and/or complete IP subnetworks from accessing the 
services offered by the SMTP service. When you do not specify anything, 
the SMTP service will accept connections from any IP address. The star 
symbol is used to denote any number between 0 and 255.

smtp.accept=*.*.*.*
smtp.accept=12.34.56.78
smtp.deny=12.34.56.*

SMTP Service for Outbound E-mail

When an item in Service Desk is assigned to a person or to a workgroup, 
an e-mail message can be send to the person or persons in the 
workgroup.

NOTE You can specify that you do not want to receive e-mail messages by 
unmarking the checkbox in the Tools options dialog box in the GUI 
console on the Advanced tab.

smtp.outbound.server

The parameter smtp.outbound.server defines the name of the SMTP 
server that relays e-mail messages to the rest of your organization and 
the outside world.

smtp.outbound.server=mail.mydomain.com

smtp.outbound.port

The parameter smtp.outbound.port defines the SMTP server IP port.

The default setting for smtp.outbound.port is: 
smtp.outbound.port=25

smtp.outbound.from

The parameter smtp.outbound.from specifies what will appear as the 
e-mail address in the From field of the outgoing message.
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smtp.outbound.from=mailmaster@mydomain.com

smtp.outbound.replyto

The parameter smtp.outbound.replyto specifies what will appear in 
the Reply-to field of the outgoing message.

smtp.outbound.displayName

The parameter smtp.outbound.displayName specifies what will appear 
as the “friendly name” in the From field of the outgoing e-mail message.

smtp.outbound.displayName=HP Service Desk
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Log Options
The parameter log.filename specifies the location of the application 
server log file. If you do not specify this option, the log file will be called 
“serverlog.txt” and it will be placed in the root directory where Service 
Desk has been installed.

log.filename=c:\temp\logserver.txt
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5 Integrating Solution Fields with 
Web Applications

This chapter explains how you can build an integration with Service 
Desk Solution fields into your Web applications.
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Service Desk allows you to build an integration with Service Desk into 
your Web applications that enables users to copy information from the 
Web application into the Solution field of Service Desk items. 

For example, if you implement this integration in a knowledge base, help 
desk personnel can search the knowledge base for solutions to reported 
incidents and questions, and then copy the found solution directly into 
the Solution field of the service call in Service Desk. This integration 
works with any Service Desk item that has a Solution field: service 
calls, incidents, and problems.

This integration allows users to copy the information into the Solution 
field of multiple Service Desk items in one go, which makes it an efficient 
feature for problem resolution. Once the solution is found, it can be 
entered in all relevant service calls, incidents, and problems in one single 
action.

To implement this integration, you must include certain Javascript 
instructions into your Web application. This requires knowledge of 
Javascript programming and HTML.

NOTE The integration works with ActiveX controls; therefore, the user’s 
Internet Explorer, Internet Options must be set to allow ActiveX 
controls. In IE4, go to View menu, select Internet Options, and then 
Security. In IE5, Internet Options can be found in the Control 
Panel, or in the Tools menu. In the the Security tab Initialize and 
script ActiveX controls not marked as safe and Run ActiveX 
controls and plug-ins to Enable or Prompt. 

Service Desk comes with an example of a Web application that 
demonstrates the integration. You can use the source code of this 
example to develop or customize your own application.

The following section describes how the example works. Section 
“Programming Instructions” on page 77 explains the Javascript code of 
the example and gives programming instructions.
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The Example Web Application
The example Web application demonstrates how users can copy 
information from a Web application into the Solution field of Service 
Desk items. You can find the example in \examples\Web 
Integration\WebControlExample.htm, in the folder where the 
SDSK_xxxxx.EXE file is extracted; by default this is the folder C:\temp. 
(In the file name SDSK_xxxxx.EXE, xxxxx stands for a five digit number 
that varies per service pack. For example, for Service Desk 3.0 Service 
Pack 3, this number is 00008.)

To copy information from this Web application into Service Desk 
Solution fields:

1. In the URL box in the Service Desk toolbar, enter the URL of the Web 
application. By default this is C:\temp\examples\Web 
Integration\WebControlExample.htm.

The Service Desk Web Integration dialog box appears.
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Figure 5-1 The Service Desk Web Integration dialog box

2. Click Load. This connects the Web application with Service Desk.

The Web Service button appears in the toolbar (disabled).
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Figure 5-2 The Web Service button

3. In the text box, enter the text you want to copy to one or more 
Solution fields.

4. Click Complete.

The Web Service button is now enabled, indicating that there is text 
available that can be copied into Solution fields.

5. Make sure all the items you want to copy the text to, are open.

6. You can now copy the text to all or one of the open items that have a 
Solution field. To see a list of all open items that have a Solution 
field, click the arrow on the Web Service button.
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Figure 5-3 Clicking the arrow on the Web Service button

• To copy the text to the Solution field of all open items: 

a. Click the Web Service button.

Figure 5-4 Clicking the Web Service button

b. The following message appears: The solution fields of 
open items will now be modified. Do you want to 
continue? Click OK to copy the text from the Web application 
into the Solution field of all open items.

• To copy the text to the Solution field of only one of the open 
items: 

a. Click the arrow on the Web Service button. A list appears of 
all open items that have a Solution field.

b. In the list, select the item you want to copy the text to, then 
press Enter. 

The text is added to the Solution field, preceded by the text "Added 
from" followed by the name of the service provider specified in the 
Web application. If the Solution field already contained text, the 
copied text is appended to the existing text, with an empty line 
between the existing text and the copied text.

7. Save the changed items. 

8. After you have copied all the information you want, click Unload to 
disconnect the Web application from Service Desk and to disable the 
copy functionality.
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The Web application integration is enabled by an ActiveX object that is 
available in Service Desk. To build the integration into your Web 
application, you must include Javascript calls to this ActiveX object in 
your HTML program file. 

TIP You can use the source code of the WebControlExample.htm file as a 
reference to see how the Javascript calls described below are 
implemented in the example. See “The WebControlExample.htm File” on 
page 79 for a listing of the source code.

Your program must do the following:

1. Include the ActiveX object, with the following code:

<OBJECT 
classid=java:com.hp.ifc.ui.web.AppWebControl.class

ID=SDWebControl
WIDTH="95"
HEIGHT="31"
ALIGN=ABSMIDDLE
STYLE="BACKGROUND-COLOR: gray;">

</OBJECT>

2. Call the function SDWebControl.connect() to connect to Service 
Desk and to load the Web integration component.

3. Get the text to be copied and define this text as the value of the 
SDWebControl.text variable.

In the example, the contents of the text box (TEXTAREA) are defined as 
the value of the solutionText.value variable. When the user 
indicates he has completed entering the text - by clicking the 
Complete button - the value of solutionText.value is passed on to 
the SDWebControl.text variable.

When the SDWebControl.text variable has a value that is not null, 
the Web Service button in Service Desk is enabled.

Service Desk handles the pasting action: when the user clicks the 
Service Web button, the text is copied into the Solution field of the 
Chapter 5  77



Integrating Solution Fields with Web Applications
Programming Instructions
selected open items.

4. Call the function SDWebControl.disconnect() to disconnect your 
application from Service Desk.

Parameters

The ActiveX control has the following parameters:

• Parameter:  SDWebControl.autoShow=” value”
where value stands for one of the possible values 
mentioned below.

Explanation:  Determines when the HP OpenView Service Desk 
Enabled logo is displayed on the Web application 
page.

Figure 5-5 The HP OpenView Service Desk Enabled logo

Possible values:  

• Parameter:  SDWebControl.serviceProvider=” value”
where value stands for one of a value a described 
below.

Explanation:  Determines the name of the service provider 
mentioned in the tooltip of the Web Service  button 
and inserted in the Solution  field before the 
copied text. 

Possible values:  Any string, for example HP OpenView Service 
Desk . 

The default is the value of the WebServiceProvider 

Value Meaning

0 Never

1 Only if opened from within Service Desk. 
This is the default.

2 Always
78  Chapter 5



Integrating Solution Fields with Web Applications
Programming Instructions
label. The value of this and other labels can be 
changed in Service Desk’s Administrator Console. 
The default value of the WebServiceProvider label is 
HP OpenView Service Desk.

The WebControlExample.htm File

The following is the source code of the WebControlExample.htm file.

<HTML>
<HEAD>
<TITLE>Service Desk Web Integration</TITLE>
<SCRIPT ID=clientEventHandlersJS LANGUAGE=javascript>
<!--

function loadButton_onclick() {
    // load the WEB component, this connects this HTML page to Service Desk (if 
opened in Service Desk)
    SDWebControl.connect();
    if (SDWebControl.isConnected()) {
        unloadButton.disabled=false;
        solutionText.disabled=false;
        solutionText.value=””;
        completeButton.disabled=false;
        loadButton.disabled=true;
        SDWebControl.text=””;
    } else {
        solutionText.value=”No Connection”;
    }
}

function unloadButton_onclick() {
    // unload the WEB component, disconnects from Service Desk
    SDWebControl.text=””;
    unloadButton.disabled=true;
    solutionText.disabled=true;
    solutionText.value=”Press Load to load the WEB component.\nThen type some 
text here and press Complete to transfer your text to Service Desk.”;
    completeButton.disabled=true;
    loadButton.disabled=false;
    SDWebControl.disconnect();
}

function passOnText() {
    //is enabled after pressing load, and enables in its turn the  “Web Service” 
button in Service Desk.
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    //pass the text in TEXTAREA  solutionText on to Service Desk. This will be 
the text, that is put into the solution fields, after clicking the “Web Service” 
button in Service Desk.
    SDWebControl.text=solutionText.value;
}

function window_onload() {
    // possible values for autoShow:
    // 2 - Allways
    // 1 - Only in ServiceDesk
    // 0 - Never
    SDWebControl.autoShow=”2”;
    // Add your name or some other identification in service provider,
    // this name is visible in tooltip of “Web Service” button and added before 
text in solution field
    SDWebControl.serviceProvider=”HP OpenView Service Desk”;
}

//-->
</SCRIPT>
</HEAD>
<BODY bgColor=#b0c4de LANGUAGE=javascript onload=”return window_onload()”>

<P><FONT size=4><STRONG>Service Desk Web Integration</STRONG></FONT>
</P>
<P><TEXTAREA ID=solutionText NAME=solutionText STYLE=”HEIGHT: 86px; WIDTH: 
400px” DISABLED>
Press Load to load the WEB component.
Then type some text here and press Complete to transfer your text to Service 
Desk.
</TEXTAREA>
</P>
<P>
<OBJECT classid=java:com.hp.ifc.ui.web.AppWebControl.class
    ID=SDWebControl
    WIDTH=”95”
    HEIGHT=”31”
    ALIGN=ABSMIDDLE
    STYLE=”BACKGROUND-COLOR: gray;”>
</OBJECT>
</P>
<P>
    <INPUT ID=loadButton LANGUAGE=javascript NAME=loadButton
    ONCLICK=”return loadButton_onclick()” TYPE=button VALUE=Load>
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    <INPUT id=unloadButton LANGUAGE=javascript NAME=unloadButton
    ONCLICK=”return unloadButton_onclick()” TYPE=button VALUE=Unload DISABLED>

    &nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

    <INPUT ID=completeButton LANGUAGE=javascript NAME=completeButton
    ONCLICK=”return passOnText()” TYPE=button VALUE=Complete  DISABLED>
</P>

</BODY>
</HTML>
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6 System Maintenance

This chapter discusses issues related to Service Desk and its relationship 
to your chosen database.
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The data that should be saved or restored resides in the database that 
the user selects. The choices are limited to Oracle and SQL Server. Any 
backup that includes the database files - for example the .dbf files for 
Oracle, rollback segments etc - or an export of the data itself, is 
sufficient.

There are no specific configuration files other than preferences on the 
client machines which must be saved individually. In fact, since specific 
files can be replaced, renamed or moved from release to release, there is 
a danger that this information may not be relayed to the system 
administrator. Therefore, it is better not to save files individually.

The system administrator, using the backup tools of his choice, can 
backup the system in the following ways:

• Application server: 
A full NT backup including the registry suffices. There are no specific 
configuration files that must be saved individually.

• Web server (for SSP): 
Depends upon the platform and directory structure. An NT backup 
can be performed as with the application server. You can also reinstall 
and copy any customized .html files to the desired directory.

• Database server: 
A backup of the database files is sufficient. The database 
administrator should be able to identify these files. Some 
administrators find it easier to reinstall the system and database 
software from scratch and then import the data.
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	To assign an existing role to a new account:
	1. Start the Service Desk application server.
	1. Start the Service Desk application server.
	2. From the
	3. In the
	4. In the
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	To link a role to an account:
	1. Access the
	1. Access the
	2. In the
	3. Select the checkboxes for the accounts that will utilize the new or modified role.
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	Time Outs
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	To change the timeout period:
	1. On the server, locate the configuration file
	1. On the server, locate the configuration file
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	Logon Screen
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	Service Desk can be set up to display a dialog box whenever a user tries to connect to the applic...
	To set Display Logon Screen:
	1. Start the Service Desk application server.
	1. Start the Service Desk application server.
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	2 Localization
	This chapter discusses how to import the XML files provided with the localization pack and how to...
	This chapter discusses how to import the XML files provided with the localization pack and how to...
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	The Localization Pack
	The localization pack consists of:
	To install a new language:

	Localizing sd_event and sd_export
	Localizing sd_event and sd_export
	Localization issues for
	[ERROR_CODES] 1010 No application server specified 1020 Cannot open the log file 1030 Failed to c...
	Other language files, for example

	Implementing the Help Files
	Implementing the Help Files
	This section explains where on the user’s system the help files will automatically be placed to m...
	When you install Service Desk 3.0, Service Pack 3, all online help
	Also, the six header files are placed in the same folder as the
	The header files are the same for all languages/locales. The files will be automatically placed i...
	The identifiers for the locales are as follows:
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	3� Rule Manager
	Rules can be created using the Rule Manager to initiate actions in response to events that occur ...
	Using Rule Manager
	Using Rule Manager
	The Rule Manager can help you optimize your Service Desk processes by using database rules to aut...
	The following diagram shows the overall concept of how the Rule Manager functions. Rules are main...
	1. An event occurs in the Service Desk database.
	1. An event occurs in the Service Desk database.
	1. An event occurs in the Service Desk database.
	2. The event is sent to the Event Queue by the Service Desk workflow layer.
	3. The Rule Manager takes the event from the queue and checks to see if there is an applicable ru...
	4. Events that fit a rule are sent to the Evaluation Manager to check the conditions set for the ...
	5. If no conditions exist or if all conditions are met the event is sent to the Action Manager an...
	6. When the timed condition is met the event is sent to the Action Manager.
	7. The Action Manager can initiate the following three tasks:


	NOTE E-mail actions and Update Service Desk database actions do not use a Rule Manager agent.
	NOTE E-mail actions and Update Service Desk database actions do not use a Rule Manager agent.
	NOTE E-mail actions and Update Service Desk database actions do not use a Rule Manager agent.
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	The Rule Manager Agent is only used to execute Command Exec actions. It is not used when performi...
	Resending Failed Actions
	Resending Failed Actions
	When a Rule Manager action cannot reach the agent it is intended for, that action is stored on th...


	Creating Database Rules
	Creating Database Rules
	The procedure below explains how you can use the Rule Manager wizard in Service Desk to create a ...
	Step 1. Select the item in Service Desk that this rule will apply to:
	Step 1. Select the item in Service Desk that this rule will apply to:
	Step 2. Set conditions for the database rule.
	Step 3. Add actions to the database rule.
	Step 4. Turn on the action:

	Creating Command Exec Actions
	Creating Command Exec Actions
	The Command Exec action is used to execute a command with a set of parameters specified by you. T...
	Example 3�1 Example Rule for Sending a Service Event
	Example 3�1 Example Rule for Sending a Service Event
	The Rule Manager in Service Desk is the starting point for setting up database rules to send outb...
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	Example 3�2 SLA Expiration Alert Action
	Example 3�2 SLA Expiration Alert Action
	The Command Exec action can be used to send a notification showing a banner on the screen of the ...
	The Command Exec action is used to show a banner when configured as follows:

	Example 3�3 Send Banner
	Example 3�3 Send Banner
	Set conditions:
	Set action


	Creating Email Actions
	Creating Email Actions
	The Send Email Message action contains parameters that you enter that will determine the message ...
	NOTE The SMTP server must be configured properly, refer to the
	NOTE The SMTP server must be configured properly, refer to the

	NOTE The outbound side of the email interface (
	NOTE The outbound side of the email interface (

	NOTE To enable sending an email to a specific machine you may have to add an "MX" record to the D...
	NOTE To enable sending an email to a specific machine you may have to add an "MX" record to the D...
	You can check whether your machine is registered at the DNS tables by running the following from ...

	Example 3�4 Example for Sending Email when CI status changes
	Example 3�4 Example for Sending Email when CI status changes
	Set conditions
	Configure the Send E-mail action as follows:

	Example 3�5 Escalation Message
	Example 3�5 Escalation Message
	Set Conditions:
	Set the action parameters:


	Creating Actions to Update Service Desk Data
	Creating Actions to Update Service Desk Data
	The Update Data action is used to update data in the Service Desk database. For example you could...
	1. Enter a
	1. Enter a
	1. Enter a
	2. Use the
	3. Use the






	4 Server/client Settings and Issues and Configuring SSP
	4 Server/client Settings and Issues and Configuring SSP
	This chapter discusses how to configure SSP and server/client settings and issues.
	This chapter discusses how to configure SSP and server/client settings and issues.

	Configuring SSP
	Configuring SSP
	In the Self Service Pages, you can easily configure the links, fonts and the customer header.
	To configure the links and the customer header, you must adjust the HTML page.
	To configure the customer header:
	To configure the links:
	To configure the font:
	Server/client Settings and Issues
	Server/client Settings and Issues
	Below, the following settings and issues from the file
	• server.root
	• server.root
	• session.timeout
	• ITP service
	• itp.port
	• itp.joinMultipleServers
	• itp. weight
	• itp.acceptConsoleClients
	• HTTP Post Service
	• SMTP Service for inbound e-mail
	• SMTP Service for outbound e-mail
	• Log options


	Server.root
	Server.root
	This is the top of the directory tree where the server’s configuration, error and log files are b...
	For Windows systems, the path is set in the registry under:

	Session.timeout
	Session.timeout
	Session.timeout
	Session.timeout

	After the session is removed from the server, the user must log on again. This happens automatica...
	Default for

	ITP Service
	ITP Service
	ITP is an IT Service Manager prorietary transport protocol built on top of TCP/IP. It is comparab...
	itp.port
	itp.port

	The
	If the IP port specified is not the default, then all clients must specify the given IP port when...
	If you use multiple application servers, make sure all application servers run on the same IP por...
	itp.joinMultipleServers
	itp.joinMultipleServers

	itp.joinMultipleServers
	itp.joinMultipleServers

	itp.joinMultipleServers
	itp.joinMultipleServers

	itp.weight
	itp.weight

	The weight parameter
	itp.acceptConsoleClients
	itp.acceptConsoleClients

	The parameter
	This parameter is used for load-balancing purposes, where the application server could be used so...
	accept
	accept

	With the accept and deny parameters, you can explicitely exclude and/or include specific IP addre...
	itp.accept=127.0.0.1 itp.accept=12.34.*.* itp.deny=123.45.67.88 itp.deny=123.45.67.89 itp.deny=12...

	HTTP Post Service
	HTTP Post Service
	The application server can run an HTTP Post Service. This service makes it possible to receive ev...
	HTTP can be set to:
	The default setting for
	http.port
	http.port

	The parameter
	The default setting for http.port is:
	accept and deny
	accept and deny

	With the accept and deny parameters you can exclude and/or include specific IP addresses and/or c...
	http.accept
	http.accept

	NOTE If you have a webserver serving the Self Service Pages running on a machine that has for exa...
	NOTE If you have a webserver serving the Self Service Pages running on a machine that has for exa...
	NOTE If you have a webserver serving the Self Service Pages running on a machine that has for exa...



	SMTP Service for Inbound E-mail
	SMTP Service for Inbound E-mail
	The application server can run an SMTP service, which can be used to receive e-mail messages that...
	The parameter
	smtp.debug
	smtp.debug

	The parameter
	The default setting for
	smtp.port
	smtp.port

	The parameter
	smtp.user
	smtp.user

	The parameter
	With the accept and deny parameters you can exclude and/or include specific IP addresses and/or c...
	smtp.accept
	smtp.accept


	SMTP Service for Outbound E-mail
	SMTP Service for Outbound E-mail
	When an item in Service Desk is assigned to a person or to a workgroup, an e-mail message can be ...
	smtp.outbound.server
	smtp.outbound.server

	The parameter
	smtp.outbound.server
	smtp.outbound.server

	smtp.outbound.port
	smtp.outbound.port
	smtp.outbound.port


	The parameter
	The default setting for
	smtp.outbound.from
	smtp.outbound.from

	The parameter
	smtp.outbound.from
	smtp.outbound.from

	smtp.outbound.replyto
	smtp.outbound.replyto

	The parameter
	smtp.outbound.displayName
	smtp.outbound.displayName

	The parameter
	smtp.outbound.displayName
	smtp.outbound.displayName



	Log Options
	Log Options
	The parameter log.filename specifies the location of the application server log file. If you do n...
	log.filename
	log.filename



	5� Integrating Solution Fields with Web Applications
	5� Integrating Solution Fields with Web Applications
	integrating Web applications with Solution fields
	Web applications:copying solutions
	copying solutions from Web applications
	solutions:copying from Web applications
	<$nopage>Web Service button:<IndexSee>see also<Default Paragraph Font> Web applications
	<$nopage>Web applications:<IndexSee>see also<Default Paragraph Font> Web Service button
	This chapter explains how you can build an integration with Service Desk
	This chapter explains how you can build an integration with Service Desk
	Service Desk allows you to build an integration with Service Desk into your Web applications that...
	For example, if you implement this integration in a knowledge base, help desk personnel can searc...
	This integration allows users to copy the information into the
	To implement this integration, you must include certain Javascript instructions into your Web app...
	NOTE The integration works with ActiveX controls; therefore, the user’s Internet Explorer, Intern...
	NOTE The integration works with ActiveX controls; therefore, the user’s Internet Explorer, Intern...

	Service Desk comes with an example of a Web application that demonstrates the integration. You ca...
	The following section describes how the example works. Section

	The Example Web Application
	The Example Web Application
	integrating Web applications with Solution fields:example Web application
	Web applications:example Web application
	WebControlExample.htm
	files:WebControlExample.htm
	The example Web application demonstrates how users can copy information from a Web application in...
	To copy information from this Web application into Service Desk
	1. In the URL box in the Service Desk toolbar, enter the URL of the Web application. By default t...
	1. In the URL box in the Service Desk toolbar, enter the URL of the Web application. By default t...
	1. In the URL box in the Service Desk toolbar, enter the URL of the Web application. By default t...
	The Service Desk Web Integration dialog box appears.
	Figure 5�1 The Service Desk Web Integration dialog box
	Figure 5�1 The Service Desk Web Integration dialog box
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	2. Click
	3. In the text box, enter the text you want to copy to one or more
	4. Click
	5. Make sure all the items you want to copy the text to, are open.
	6. You can now copy the text to all or one of the open items that have a
	6. You can now copy the text to all or one of the open items that have a
	Figure 5�3 Clicking the arrow on the Web Service button
	Figure 5�3 Clicking the arrow on the Web Service button
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	• To copy the text to the
	• To copy the text to the
	• To copy the text to the
	a. Click the
	a. Click the
	a. Click the
	Figure 5�4 Clicking the Web Service button
	Figure 5�4 Clicking the Web Service button
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	b. The following message appears:


	• To copy the text to the
	• To copy the text to the
	a. Click the arrow on the
	a. Click the arrow on the
	b. In the list, select the item you want to copy the text to, then press



	The text is added to the

	7. Save the changed items.
	8. After you have copied all the information you want, click


	Programming Instructions
	Programming Instructions
	integrating Web applications with Solution fields:programming instructions
	Web applications:programming instructions
	copying solutions from Web applications:programming instructions
	programming Web applications
	SDWebControl
	The Web application integration is enabled by an ActiveX object that is available in Service Desk...
	TIP You can use the source code of the
	TIP You can use the source code of the

	Your program must do the following:
	1. Include the ActiveX object, with the following code:
	1. Include the ActiveX object, with the following code:
	1. Include the ActiveX object, with the following code:
	<OBJECT classid=java:com.hp.ifc.ui.web.AppWebControl.class �����ID=SDWebControl �����WIDTH="95" �...
	<OBJECT classid=java:com.hp.ifc.ui.web.AppWebControl.class �����ID=SDWebControl �����WIDTH="95" �...


	2. Call the function
	3. Get the text to be copied and define this text as the value of the
	3. Get the text to be copied and define this text as the value of the
	In the example, the contents of the text box (
	When the
	Service Desk handles the pasting action: when the user clicks the

	4. Call the function

	Parameters
	Parameters
	parameters:for SDWebControl
	parameters:for Web application integration
	programming Web applications:parameters
	SDWebControl
	The ActiveX control has the following parameters:
	• Parameter:
	• Parameter:
	• Parameter:
	• Parameter:
	• Parameter:
	HP OpenView Enabled logo
	HP OpenView Enabled logo
	HP OpenView Enabled logo
	HP OpenView Enabled logo
	logo HP OpenView Enabled
	Web applications:displaying the HP OpenView Enabled logo




	Explanation:
	Explanation:
	Determines when the HP OpenView Service Desk Enabled logo is displayed on the Web application page.
	Determines when the HP OpenView Service Desk Enabled logo is displayed on the Web application page.
	Figure 5�5 The HP OpenView Service Desk Enabled logo
	Figure 5�5 The HP OpenView Service Desk Enabled logo
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	Possible values:
	Possible values:
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Value
	Value

	Meaning
	Meaning



	<TABLE BODY>
	<TABLE ROW>
	0
	0
	0


	Never
	Never


	<TABLE ROW>
	1
	1

	Only if opened from within Service Desk. This is the default.

	<TABLE ROW>
	2
	2
	2


	Always
	Always









	• Parameter:
	• Parameter:
	• Parameter:
	• Parameter:
	• Parameter:
	service provider for Web application integration
	service provider for Web application integration
	service provider for Web application integration
	service provider for Web application integration
	Web applications:service provider
	Web Service button:service provider in tooltip




	Explanation:
	Explanation:
	Determines the name of the service provider mentioned in the tooltip of the

	Possible values:
	Possible values:
	Any string, for example
	Any string, for example
	The default is the value of the WebServiceProvider label. The value of this and other labels can ...
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	The following is the source code of the WebControlExample.htm file.
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	This chapter discusses issues related to Service Desk and its relationship to your chosen database.
	This chapter discusses issues related to Service Desk and its relationship to your chosen database.

	System backup
	System backup
	The data that should be saved or restored resides in the database that the user selects. The choi...
	There are no specific configuration files other than preferences on the client machines which mus...
	The system administrator, using the backup tools of his choice, can backup the system in the foll...
	• Application server: A full NT backup including the registry suffices. There are no specific con...
	• Application server: A full NT backup including the registry suffices. There are no specific con...
	• Web server (for SSP): Depends upon the platform and directory structure. An NT backup can be pe...
	• Database server: A backup of the database files is sufficient. The database administrator shoul...
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